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TYPEFI

Getting started with Typefitter

Typefitter will help you fix problems with your type while maintaining top quality typography. Typefitter
lets you manually tighten and loosen text, and create Typefit rules that automatically fix copy problems like
oversets, runts (short lines) and imbalanced columns. Each Typefit style has its own set of rules, so you
can customize exactly the rule sets that you need for different situations and easily switch back and forth
between them. All of these features help make Typefitter a considerable production timesaver.
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Overview
Manually fit text

Typefitter allows you to manually tighten and loosen text by nudging your justification and tracking
settings up or down. Typefitter will nudge a whole group of settings all at once, which is a big time-saver.
Because Typefitter emphasizes changing justification settings like word spacing, letter spacing and glyph
scaling, you can tighten or loosen your type without compromising high quality typography.

Automatically fit text

With Typefitter, you can also create a set of rules that will find and attempt to automatically fix problems
with your text. Each Typefit style has a set of Typefit rules that define what kind of problems Typefitter will
catch. You can find and fix rule violations one at a time by using the find next or previous buttons, or you
can find or fix them all at once.

Cetting started with Typefitter 4



Typefitter has six different rule types to choose from, and each rule type will fix a specific problem with
your text. The six rule types are:

Runts: a paragraph with a short line of text at the end

Oversets: a text frame with more text than the frame can show

Imbalanced columns: Columns that are not flush with the bottom of their frame
Short paragraphs: paragraphs that are less than a certain number of lines

Long paragraphs: paragraphs that are more than a certain number of lines

Inexact paragraphs: paragraphs that are not exactly a certain number of lines

How Typefit rules work

Typefitter automatically fixes problems with your type using Typefit rules. Each Typefit rule defines
three things:

- The problem that this rule tries to fix, such as runts or oversets
- Which paragraph styles the rule can modify to fix the problem

- Which attributes the rule can adjust to fix the problem, such as word spacing or tracking

You can tell Typefitter to go through the text in your document or story. It goes through paragraphs,
columns and stories, checking all the rules to see if there is a violation. When Typefitter finds a violation, it
can attempt to automatically fix it.

When Typefitter tries to fix a rule violation, it will find the smallest adjustment it needs to make to the
attributes it is allowed to modify in order to fix the problem. If it can’t fix the problem without making
adjustments larger than the rule limits defined in your Typefit style, it will leave your text unchanged.

Rules are defined in a Typefit style. A Typefit style can hold as many rules as you'd like. You can create
different Typefit styles with different sets of rules suited for different occasions. For example, sometimes
you may only want to fix runts, while at other times you might want to fix both runts and oversets. Just
create two different styles with different sets of rules, and then you can switch back and forth between
them just by switching styles.

How the tighten/loosen buttons work

The tighten and loosen buttons are designed to manually tighten or loosen text quickly and easily without
compromising the quality of your type. When you nudge your text tighter or looser, Typefitter makes
adjustments to a paragraphs justification settings. These settings affect both justified and non-justified
text, and InDesign uses these settings to decide the best spacing for that paragraph. As you play with
Typefitter, you'll notice that the way type is affected by these adjustments is far more subtle and refined
than if you simply highlighted the whole paragraph and adjusted the tracking.

There are times, however, when you might want to nudge the tracking in addition to the justification
settings. Typefitter lets you do this as well.

All of these settings are controlled in a Typefit style. When editing a Typefit style, you can control the
degree that each of the tighten and loosen buttons will nudge your settings. As you work with Typefitter,
you choose which style is most appropriate for your situation. You can, for example, create different styles
for different fonts, knowing that some fonts will accommodate more tightening than others.
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Using Typefitter

The Typefitter panel is the main location to access Typefitter functionality. The buttons on the panel allow
you to tighten, restore and loosen text. They also let you find and fix Typefit rule violations. Using the
Typefitter panel menu, you can create, duplicate, edit, delete and load styles.

Tighten or loosen text

Current typefit style

— Typefitter panel menu
[Defuy [ TIv]

HAAE FAAE AA AtRA A

. . . Enforce typefit rules . . .
Find next violation P Fix/find next violation

¢ Typefitter

Style:

(forward or backward) —— A& & B @& & —— (forward or backward)
Find all violations — ve) & 7 [ —— Undo all Typefitter changes
Results:
- Found: Paragragh has runt fhat is 5 A
characters long
v
f 9 @
Fix selected violation Fix all violations

To display the Typefitter panel, select Window » Typefitter.

To hide or show the Typefit rule buttons
The bottom row of buttons, used for finding oversets and runts, can be hidden or shown.

To hide the buttons, double-click on the up-down arrows on the Typefitter title tab.

Assigning keyboard shortcuts to Typefitter buttons

All the buttons on the Typefitter panel can be assigned keyboard shortcuts, even if they don’t have menu
items associated with them. Just look in the keyboard shortcut editor (Edit ~ Keyboard Shortcuts) under
the Typefi Software product area, and you can assign shortcuts to any of the buttons.

Manual copy-fitting: tightening and loosening text

To tighten text, click the Tighten or Tighten More buttons. To loosen text, click the Loosen or Loosen
More buttons. To define precisely what adjustments those buttons make, you can edit the Typefit style.
For more information on what these buttons do and how they work, see Tighten and loosen settings.

Automatic copy-fitting: finding and fixing rule violations

Typefitter uses a rule-based system to automatically fit type. For an overview of how rules work, see How
Typefit rules work. For details on how to create and edit rules, see Defining and editing Typefit rules. The
following section will show you how you actually use Typefitter to automatically fit your copy by finding
and fixing rule violations.

Finding violations one at a time

You can find the next or previous rule violations using Find Next and Find Previous. These buttons will
start looking from the currently selected text and go either forwards or backwards looking for the next rule
violation. If the scope is set to be document wide, and nothing is selected, Typefitter will start searching
in the first story on the current spread. As you move forward and backwards through a document, the
Results window in the Typefitter panel will tell you what you've found.
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If Typefitter finds a rule violation, it will highlight the text that violates the rule. You can then use Fix
Current Violation to fix it, or you can use the fix current and find next/previous buttons to fix the current
violation and find the next or previous one.

Finding all violations

You can find all rule violations in a story or document at once with Find All Rule Violations. When
you click this button, Typefitter finds all violations of the current rule set and reports them in the
Results window.

Fixing violations one at a time

After you use Find Next or Find Previous to select a violation, you can fix it using Fix Current Violation.
You can also fix the current violations and find the next or previous violation in a single step.

Fixing all violations

You can fix all the rule violations in a story or document by clicking Fix All.

Scope: Story vs Document

In the Typefitter panel, you can choose to enforce rules in either the story or the document. If you enforce
rules in the document, Typefitter will check all stories when finding and fixing rule violations. If you
choose to enforce the rules only in the story, Typefitter will only look in the currently selected story when
finding and fixing rule violations.

Removing Typefitter changes

You can remove any changes that Typefitter has made to your current selection using the Restore button.
You can remove all changes in a story or document using Undo All Changes. These buttons remove all
changes that Typefitter made, whether they were made when fixing rule violations or if they were made
using the tighten and loosen buttons. If you made local overrides without using Typefitter, then those
changes are preserved.

To remove Typefitter changes from the current selection:

Select the text you would like to restore, or place your cursor in a paragraph you'd like to restore

Click Restore

To remove Typefitter changes from the entire story or document:

Choose whether you are removing changes from the selected story or the whole document under Enforce
Typefit rules in the Typefitter panel

2 Click Undo All Changes

Cetting started with Typefitter
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Highlighting Typefitter changes

You can have Typefitter highlight any text that it has modified, either via manual tightening or loosening,
or via automatic copy-fitting with Typefit rules. This feature is turned on or off in the InDesign Preferences
dialog. You can also define what colors will be used when highlighting Typefitter changes.

General

Sync Settings

Interface

Type

Advanced Type

Composition

Units & Increments

Grids

Guides & Pasteboard

Dictionary

Spelling

Autocorrect

Notes

Track Changes

Story Editor Display

Display Performance

Appearance of Black

File Handling

Clipboard Handling

Typefitter

Preferences
Typefitter
Appearance
M Highlight Typefitter Changes
Loosened Text: [E Light Blue v|
Tightened Text: E Orange v|
Cancel | I OK

Creating and editing Typefit styles

1 To create a style, choose New Typefit Style from the Typefitter panel menu, or click the New Typefit Style
button at the bottom of the Typefitter panel

2 To edit a style, select the style you'd like to edit in the Style dropdown in the Typefitter panel

3 Then select Edit current style from the Typefitter panel menu, or click the Edit current style button at the
bottom of the Typefitter panel

When you create or edit a style, you will work in a selectable dialog with six different panes:

- Typefit Rules
Rule Limits

Loosen Text

Loosen Text More

- Tighten Text

- Tighten Text More

We will now look at each pane of this dialog in more detail.

Cetting started with Typefitter
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Typefit rules

This is where you create and organize your Typefit rules. There are two areas: a list of your Typefit rules,
and a runt definition area.

Edit Typefit Style

ypeftifules Style Name: | [Default]

Typefit Rule Limits
Loosen Button Typefit Rules

Loosen More Button — Manage Typefit Rules

Tighten Button

v graph Rules

Tighten More Button

Fix runts by modifying Word Spacing, Letter Spacing and Glyph Scaling on All Paragraphs

Fix runts by modifying Tracking on All Paragraphs

¥ Column Rules

Force text even with column bottom by modifying Space Before and Space After on All Paragraphs

Force text even with column bottom by modifying Leading on All Paragraphs

Fix gaps at column bottom by modifying Word Spacing, Letter Spacing and Glyph Scaling on All Paragraphs

W Story Rules

Fix oversets by modifying Word Spacing, Letter Spacing and Glyph Scaling on All Paragraphs

| New | | Edit | | Duplicate | | Delete

— Runt Definition

Arunt is a line with or fewer characters.

Cancel | I OK

Manage Typefit rules
Rules are grouped according to type. The three types of rules that Typefitter currently handles are:

- Story Rules: Rules that apply to a whole story, such as fixing oversets
- Column Rules: Rules that apply to an entire column, such as column balancing

- Paragraph Rules: Rules that apply only to a paragraph, such as fixing runts or ensuring that a
paragraph is a certain number of lines long

Each rule is fully described in this list. If the description is too long, float your mouse over it to see the
tool tip that shows the full text.

When Typefitter executes its rules, it first checks story rules, then column rules, then paragraph rules.
Within each category, it executes the rules according to the order they are listed in the rule list.

You can have multiple rules of the same type that affect the same text. You may want to do this if you
want to first try fixing a problem with one set of attributes, and if that doesn’t work, then trying another
set of attributes. For example, you can set up two rules to fix runts, where the first would modify letter
spacing and word spacing, while the second would modify tracking. Typefitter first tries to fix the violation
by changing word and letter spacing, and if that doesn’t succeed it would try to modify tracking.

You can create, edit, duplicate or delete rules in this panel using the buttons at the bottom of the rule list.
For more information, see Defining and editing Typefit rules.

Runt definition

In Typefitter, a runt is defined as a line at the end of a paragraph that is shorter than a certain number of
characters. This is where you tell Typefitter how short a line at the end of a paragraph needs to be in order
to be considered a runt.
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Rule limits
When Typefitter tries to fix a rule violation, it is only allowed to modify an attribute a certain amount.

How much you're willing to allow Typefitter to modify is defined here in the Rule Limits panel.

Edit Typefit Style
Typefit Rules Style Name: ![Defau{t]
Typefit Rule Limits
Loosen Button Typefit Rule Limits
Loosen More Button
Tighten Button Maximum  Maximum O Limits are percentages
Tighten More Button Decrease Increase ® Limits are values
Amount Amount

Space Before:

O
o
O

Space After:

O
o
O

Leading:

Font Size:

O
o
O

Tracking:
Word Spacing:

°
B

B

| |lo| o 8 oo
X o
B O
o o o o

Letter Spacing:

o
X
o
X

5%

Rule Precision:

N
R[S

Glyph Scaling:

| Cancel | I OK

For each attribute, you can set a limit on how much Typefitter can increase or decrease the existing value.

These limits are not cumulative. That is, they don't keep track of how much Typefitter has changed a
given attribute in total. Rather, they only limit how much Typefitter can change every time it tries to fix an
individual violation.

Percentage vs. Absolute
Rule limits can be defined as either a percentage of the existing value or as an absolute value.

When limits are defined as an absolute value, Typefitter will only modify an attribute up to the amount
listed in the rule. If you define the limit for increasing space before to be 6 points, then Typefitter will
never try to increase space before by more than 6 points when trying to fix a rule violation, regardless of
what value was originally applied.

When limits are defined as percentages of the applied value, Typefitter will look at the value that’s
already applied and limit its changes to a percentage of that value. For example, if you define the limit
for increasing space before to be 10%, then Typefitter will only increase space before by 10% of the value
that's already applied.

Note: If you want to create a rule that will only modify text that already has an attribute applied, use

percentage limits. For example, using percentage limits, if a paragraph has a space after of o, then
Typefitter will never modify space after on that paragraph, because any percentage of o is always o.

Cetting started with Typefitter
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Rule precision

Precision defines how careful Typefitter will be when trying to fix a rule violation. Typefitter uses different
algorithms to find the smallest change it needs to make to fix a rule violation. However, the more precise
it is, the slower it gets, because the algorithms take more time. The precision defines how precise
Typefitter is when fixing a violation. The smaller the number, the more precise Typefitter becomes, and
the longer it takes to fix rules.

Tighten and loosen settings

There are four panes of this dialog that cover tightening and loosening, and they look very much alike.
They are Loosen Text, Loosen Text More, Tighten Text, and Tighten Text More. Each pane defines what
happens when you click the corresponding button on the Typefitter panel.

Edit Typefit Style

DypeiiRules Style Name: ![Defau{t]

Typefit Rule Limits

A Loosen Button

Loosen More Button

Tighten Button Minimum  Desired Maximum

jiohtsniMorelEriion Increase Word Spacing By: [1% | 1% | [1% |
Increase Letter Spacing By: |0.3% | |0.3% | |0.3% |
Increase Glyph Scaling By: |1% | |1% | |1% |

Increase Tracking By: El /1000 em

Cancel | I OK

Each of the four buttons can be set to nudge the spacing up or down a different amount.

Note: You are not setting absolute values here, but only nudge amounts for each button. For example, for
Tighten, you may only want to set Decrease Word Spacing By to 1% for Minimum, Desired and Maximum.
This doesn’t mean that when you hit the tighten button, the paragraph will be set to have word spacing of
1%. It means that the values that paragraph has for word spacing will be decreased by 1% every time you
hit the tighten button.

Typefitter modifies tracking and justification settings in order to fit type. Tracking controls the spaces
between all letters, and gives a less desirable visual effect when tightening or loosening text. The
justification settings control the degree to which InDesign is allowed to deviate from normal word
spacing, letter spacing, and glyph scaling. Using justification settings produces a much better

visual effect.

Minimum, maximum, and desired

Minimum and Maximum values define a range of acceptable spacing for justified paragraphs. The Desired
value defines the desired spacing for both justified and unjustified paragraphs. The more the minimum
and maximum values differ from the desired value, the more leeway you give InDesign to increase or
decrease spacing when justifying a line.

Cetting started with Typefitter
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Word Spacing

Word spacing is the space between words that results from pressing the spacebar. At 0% no additional
space is added or removed between words.

Letter spacing

Letter spacing is the distance between letters and includes any kerning or tracking values. Changing letter
spacing slightly (x29) is barely perceptible and can dramatically improve the evenness of type. At 0% no
additional space is added or removed between letters.

Clyph scaling

Glyph scaling is the adjustment of the horizontal scale of your type. When used judiciously (x2%) glyph
scaling can significantly improve the evenness of type. At 0% your type is not scaled.

Note: If you are using the Adobe Single-line Composer, setting a narrow range in the Minimum and
Maximum values helps achieve a desired result. However, setting a narrow range may not be beneficial
with the Adobe Paragraph Composer, because it decreases the difference between a reasonable break and
a bad break over a range of lines. If you change the default values for the Adobe Paragraph Composer, be
certain the values you use can accommodate a generous range.

Note: When specifying word spacing, Minimum should be less than or equal to the percentage set for
Desired, and Maximum should be greater than or equal to the percentage set for Desired.

Defining and editing Typefit rules

Edit Typefit Rule

Rule Type: |Fix story oversets v|
Word Spacing, Letter Spacing and Glyph | 4|
Attributes To Modify: |scaling Edit Attributes
v
All Paragraphs :
Rule Applies To: Edit Styles
v
Cancel | I OK

Typefitter currently offers eight rule types. You can only choose a rule type when creating a new rule; once
a rule has been created, you cannot change the rule type.

Fix story oversets

This rule will find any overset stories in your document and attempt to fix them.

Fix stories with a short final column

This rule will fix a story whose final column is shorter than a certain number of lines. An example of
where this might be useful is a chapter in a book, where the last page in the book is only three lines long.
This rule will go through all the text in the story previous to the given column and try to first loosening
paragraphs to add on lines, and if that doesn’t work, it will try tightening paragraphs to take away lines.

Cetting started with Typefitter



Force text even with column bottom

The rule will check every column to see if it is flush with the bottom of the frame. If it isn't, it will adjust
attributes that affect vertical spacing (space before, space after, and leading) to get the column to be flush
with the bottom of the frame.

Fix gaps at column bottom

The rule will check every column to see if there is a gap at the bottom of the column larger than a
certain size you set in the rule. If the rule finds a gap, it will try to fix it by first tightening, then loosening
paragraphs in the column. This is very useful when working with stories that are locked to a baseline grid.

Fix runts

A runt is defined by Typefitter as a line at the end of a paragraph that is shorter than a certain number of
characters. You can define how many characters make up a runt in the Typefit Rules pane of the dialog.
Typefitter will try to fix runts first by tightening a paragraph up, and if that doesn’t work it will try to loosen
the paragraph.

Fit paragraphs to at least ___ lines

This rule will make sure that paragraphs are at least a certain number of lines. If a paragraph has less than
that number of lines, Typefitter will attempt to loosen the text to make it that number.

Fit paragraphs to at most ___ lines

This rule will make sure that paragraphs are at most a certain number of lines. If a paragraph has more
than that number of lines, Typefitter will attempt to tighten the text to make it that number.

Fit paragraphs to exactly ___ lines

This rule will make sure that a paragraph is a specific number of lines long. It will tighten or loosen the
paragraph to try to get it to be the desired number of lines.

Attributes to modify

In each rule, you can define what attributes Typefitter will modify when it tries to fix a violation of that
particular rule. The changes that Typefitter makes when fixing a rule are made as local overrides. What
follows is a list of all the attributes Typefitter might modify. Paragraph attributes apply to an entire
paragraph, while character attributes apply to an individual run of text.

Edit Typefit Rule Attributes

Choose attributes that the rule should modify

Available To Modify
Space Before | >> | Word Spacing
Space After Letter Spacing
Leading Giyoh Scaiing
Font Size
Tracking

OK I | Cancel

Cetting started with Typefitter
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Note: You might find that some of these attributes aren’t available when working on a particular rule. This

is because the attributes you can use will change from one rule to another.

Attribute Attribute Type
Leading Character
Font Size Character
Tracking Character
Space Before Paragraph
Space After Paragraph
Word Spacing Paragraph*
Letter Spacing Paragraph*
Glyph Scaling Paragraph*

Note: The justification settings for word and letter spacing and glyph scaling (minimum, desired and

maximum) are modified together; all three attributes are adjusted at once.

Rule applies to

You can limit what text Typefitter modifies when fixing violations by defining a set of paragraph styles
within the rule. When Typefitter finds a rule violation in a column or a story, it will only modify text within
that column or story that is styled with one of those paragraph styles. If the rule is a paragraph rule, it will

only look for violations in paragraphs styled with one of those paragraph styles.

You can also have a rule apply to all text by using the Apply rule to all paragraphs option.

Choose paragraphs for rule

O Apply rule to all paragraphs

® Apply rule to paragraphs styled with:

ToTTTe

Heading 1

<

Heading 2

Heading 3

Heading 4

Normal

Code

Ordered List

Unordered List

Caption

Table Body

OROOCOOOOO

Table Heading

Kl

Cancel

0K |

For example, if you are balancing columns but only want your rule to modify leading on section headers,
Sec_Head_A and Sec_Head_B:

Create a Typefit rule of the type Force text even with column bottom

In the Create Typefit Style dialog, click Edit styles

In the Choose paragraphs for rule dialog, choose the Apply rule to paragraphs styled with radio button (if

you wanted the rule to apply to all text, you'd choose Apply rule to all paragraphs)
Select the Sec_Head_A and Sec_Head_B paragraph styles

Click OK and save the style

Cetting started with Typefitter
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Now that rule will try to fix imbalanced columns by adjusting leading only on text styled with Sec_Head_A
and Sec_Head_B.

Line count

When creating a Typefit rule that fits a paragraph to a minimum, maximum or exact line count, the Line
Count field will appear in the Create Typefit Rule dialog. Use this setting to define how many lines you
want the paragraph to be.

Loading styles from another document
You can load (import) Typefit styles from another InDesign document into your active document. Doing

so will also import any paragraph styles referred to in a Typefit style.

To load styles from another InDesign document:

In the Typefitter panel menu, choose Load Typefit Styles

Select the InDesign document containing the styles you want to import

If the incoming styles conflict with existing styles, a dialog will appear allowing you to Overwrite or
Rename; your choice will apply to all styles that have a conflict

Deleting styles
You can delete styles from a document or from the application.

To Delete a Style:
Select the style name you want to delete

Choose Delete Current Style from the Typefitter panel menu; or click the Delete Typefit Style button at
the bottom of the Typefitter panel

Duplicating styles

You can duplicate an existing style. All style information is copied from the existing style to the
duplicate style.

To Duplicate a Style:

Select the style name you want to duplicate

Choose Duplicate Current Style from the Typefitter panel menu

Default Typefit styles

There is always a default Typefit style, called [Default]. You can’t rename or delete this style, but you can
edit it. The [Default] style contains some preset Typefit rules so that you can get started using Typefitter
quickly. These rules can be edited, duplicated or deleted as you'd like.

Additionally, when you first start Typefitter, you'll see a few Typefit styles already created with individual
rules. Again, these exist to help you get started, but you can ignore or delete them as you'd like.

Like other styles in InDesign, any styles that are created when no document is open will be copied over to
newly created documents.

Cetting started with Typefitter
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Installation and activation

Installing Typefitter

In order for InDesign to load a plug-in, it has to be in the Plug-Ins directory wherever you have InDesign
installed. You can put a plug-in anywhere underneath that directory and InDesign will load it.

To install Typefitter, simply launch the installer. It will place the Typefitter plug-ins into your InDesign Plug-
ins directory, along with any support files.

Activation
When you purchase a Typefi plug-in, you are sent a serial number that you then use to activate the demo
version to be the full working version.

[ ) Activate Typefitter...

— 1. Enter Activation Key
Enter the activation key you received with your purchase:

— 2. Activate Product
| : : | This will send your activation key to Typefi's servers.
Activate Automatically You must be to the internet.
" This will launch the manual activation wizard.
Activate Manually You will need access to a web browser.

Cancel

Note: that you must be logged in as an administrator to activate or purchase the plug-in.

Activating using the internet
There are two ways to start the activation process

From the Typefitter splash screen, click Activate

From the Help » About Plug-Ins menu (Win) or InDesign » About Plug-Ins menu (macOS), select
Typefi » Typefitter » Activate

Enter your activation key, and then click Activate Automatically. This will connect with Typefi's
activation servers, check if the serial number is valid, and if it is, will unlock the plug-in. Click Done to
dismiss the dialog.

Activating manually

Some networks have firewalls or proxies that don’t allow the plug-in to activate with Typefi's activation
servers. To get around this, we offer a manual activation process. To activate manually, follow all the steps
outlined above, but before clicking on the Activate Automatically button, disconnect or deactivate your
Internet connection. The plug-in will detect that there is no connection, and a wizard will launch to allow
you to manually activate. The wizard will guide you through the process.

Installation and activation
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Deactivating Typefitter

If you want to move Typefitter from one machine to another one, you need to first deactivate the machine
you have already activated. To do this, go under Help » Deactivate Typefi Plug-in.

Installation and activation 17
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APPENDIX:
Extending Typefitter

Typefitter for InDesign Server

Typefitter is also available for both InDesign CS6 Server and InDesign CC Server. As with all
InDesign Server plug-ins, Typefitter for InDesign Server is accessed via scripting. For development
purposes, Typefitter for InDesign Server also includes an additional Typefitter Scripting plug-in for
InDesign (desktop).

Typefitter Scripting includes sample scripts that fully illustrate how to automate your copy-fitting process.
The scripts are installed in the plug-ins folder right next to Typefitter, in a folder called Scripts. The scripts
include detailed comments that explain how to access Typefitters features. You can also use the object
browser offered by the various languages to examine the objects and methods added by Typefitter.
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